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Disclaimer
1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.
2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.
3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.
4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.
5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.
Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.
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From The Chief Editor's Desk ...
by repealing net neutrality, it allows ISPs to throttle
content that they don’t think you should have access
to (think torrent downloads of the PCLinuxOS ISOs),
and allowing them to charge content providers (think
Netflix and Google) “premiums” for preferential data
speeds. The latter will allow ISPs to essentially set
up high speed, “pay-for-play” fast lanes to the
internet. Everyone else – nonprofits, small startups,
individuals, Linux distributions, etc. – will be
relegated to using the internet “slow lanes,” unable
to pay the toll for one of the preferential fast lanes.
Even Netflix has come out in opposition to the repeal
of net neutrality. It makes sense, as a repeal will
mean that they will have to pay the toll to be in the
“fast lane,” thus costing them more to do business.

PHEW! Now that the holiday season is behind us,
many of us can take a collective sigh of relief … at
least, until next year.
Winter has my area in a deep freeze grip.
Temperatures through the New Year’s is supposed
to stay below freezing for much of the foreseeable
future. At some points, and on successive days,
we’re expecting temperatures below 0° F (-18° C) for
the low temperature at night. The wind chill (or “Real
Feel”) temperatures are expected to be as low as
-27° F (-33° C).
Brrrrrr! There’s no doubt that winter has arrived, and
in full force. It was only a couple of weeks ago that
the kids were playing outside in light jackets, with
temperatures in the 50s and 60s (degrees
Fahrenheit). Since Ryan is home for holiday break –
and they can’t go outside on account of the frigid
temperatures – they are getting “cabin fever”
already.
Meanwhile, mom and dad keep working incessantly.
The “influenza season” has hit at the hospital, with
Missouri being one of the hardest hit areas in the
U.S., up to this point. Lots and lots of sick patients in
the hospital, with little relief in sight. This year’s
quadrivalent seasonal flu vaccine missed the mark –
again – targeting the WRONG strains of the flu.
There is still value in the mismatched flu vaccine,
however, as it is likely to minimize the symptoms and
severity of influenza, should you be so unfortunate
to be infected. There has been progress in the past
several years in development of a “universal”
influenza vaccine. I, for one (since I work on the
“front lines” with patients being treated for influenza),
can’t wait until the work on this universal vaccine
bears fruit.
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This is not a discussion of the political aspects of the
repeal of net neutrality, despite how it has the
potential to affect internet users world wide. Read on
for what I think is the most disturbing aspect of the
net neutrality repeal.
As you might imagine, FCC Commissioner Ajit Pai
has been in the news a lot lately, trying to explain the
U-turn on net neutrality. Pai, who’s former employer
was Verizon Wireless, has been overwhelmingly in
favor of repealing the young net neutrality rules.
Yeah. Sure. There’s no conflict of interest there,
coming from one of the largest ISPs!

Recently, the United States FCC repealed the net
neutrality laws that were enacted just a few years
ago. This has the potential to affect internet users
across the globe, and not in a good way. Basically,

He has had to endure somewhat of a hot seat in the
interviews he has given, especially since net
neutrality has broad popular support across all
political spectrums. Over the course of those
interviews, Pai’s “story” changes, depending on what
aspect of net neutrality he is discussing. Check out
this video (7 minutes, 37 seconds), for example.
The first time I viewed the video, I felt that something
was amiss, but couldn’t put my finger on it … at least
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right away. So, I watched it again. And then, it hit
me: Pai was LYING!
Check out this article from Business Insider. It
describes 12 things to look for to know how to tell if
someone is lying to you, just by looking at their face.
If you’re not familiar with the “signs” that someone is
lying to you, this article should help. Also, if you feel
like people are often lying to you, then learning
these signs could help prevent you from being a
victim, yet again.
Almost immediately on the second time through the
video, I noticed Pai shaking his head – ever so
slightly – in a “no” pattern as he was making his
case for repealing net neutrality, and again later
when talking about “throttling” by ISPs in the past.
This indicates that even he doesn’t believe the
words he is speaking. In short, he’s lying. It’s a cue
from the subconscious mind when we lie that is
nearly impossible to hide. I also noticed him blinking
excessively as he talked in favor of the net neutrality
repeal. This is another cue from the subconscious
mind when we lie that is nearly impossible to hide.
The average person blinks every six to 10 seconds
… or about six to 10 times per minute. Humans tend
to blink more when they are lying. There may have
been other signs of lying, but those were the two
that immediately stood out to me.
Why anyone would put an “industry insider” in
charge of the government agency that oversees the
very industry that the “insider” just worked for, is
way, way beyond my level of comprehension. Just
common sense tells you that the interests of
consumers and everyday users won’t be at the
forefront of their decisions. Rather, the industry that
person just left will receive the lion’s share of
attention, with decisions favoring the industry over
common users and consumers. This is a classic
case where the interests of consumers (fair access
for all) and the interests of the “industry” (greed) are
polar opposites. And sure enough, that was
demonstrated in this case of repealing net neutrality.
Fortunately, the battle for net neutrality isn’t over yet
PCLinuxOS Magazine

despite the FCC’s repeal, so we’ll have to see how
this eventually plays out. Proponents for net
neutrality are requesting Congressional review of the
repeal.
So, until next month, I bid you peace, happiness,
serenity and prosperity.
The PCLinuxOS name, logo and colors are the trademark of
Texstar.
Looking for an old article?
Can't find what you want? Try the

PCLinuxOS Magazine's
searchable index!
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Firefox 57: Faster, Leaner, Meaner
by Paul Arnote (parnote)
On November 14, 2017, the web earned a speeding
ticket … if you’re a Firefox user. On that day, Firefox
57, a.k.a. Firefox Quantum, was released to the
world.
I have to admit that despite being a Firefox user
since version 1.0, I had also abandoned Firefox. It
had become slow and bloated. I stuck with it for as
long as possible, but at the end (Firefox 56), I had
temporarily quit using Firefox. I switched to using
Opera, instead. With Opera, I discovered the speed
and stability that Firefox used to have, but that had
been lacking from Firefox for the several last
releases.
Indeed, Mozilla’s Firefox has suffered in recent
years. They lost their “most popular browser” crown
to Google Chrome several years ago. Today, Firefox
holds onto only 14 percent of the browser market
(virtually tying Apple’s Safari browser for market
share), while Chrome holds a market share well over
50 percent.
Firefox 57 represents a full rewrite of the browser.
Over 75 percent of the Firefox code underwent
changes, with over 5,000,000 lines of code
impacted. Lots of bugs were eliminated, as Firefox
overhauled its primary rendering engine. It adds a
new, multicore CSS engine, as well as tab
prioritization. There are so many changes to the new
Firefox that it’s difficult to know exactly where to
start.
In the end, Firefox 57 is twice as fast as Firefox 52
(released just six months prior). It uses 30 percent
less memory than Google Chrome. The Firefox 57
package in the PCLinuxOS repository is a lean 44
PCLinuxOS Magazine
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MB in size, while the other “mainstream” browsers
(Google Chrome, Opera and Flashpeak Slimjet) tip
the scales at a hefty 50-some-odd MB in package
size.
Meanwhile, you better tighten your seatbelts. Mozilla
hopes to make another speed increase in early 2018
with the release of WebRender, a.k.a. Quantum
Render. With it, they hope to make future versions of
Firefox twice as fast – yet again – as Firefox 57.

Changes Around Every Corner
After you get your hair back in place after being
blown away by Firefox 57’s new infusion of speed,
you will also notice a lot of changes. Some are
subtle, some work completely in the background,
and others are not-so-subtle. While not a complete
list of all changes, I’m going to try to list some of the
more notable ones.
The first thing you might notice is a newer, fresher
user interface. Called Photon, it represents the first
major interface redesign by Mozilla since Firefox
29’s Austrailis interface.

Here is what Mozilla has to say about Photon:
Photon is our approach to designing and building
modern, intuitive, delightful experiences, and appears in
Firefox starting with version 57. The Photon Design
System houses guidelines, reusable UI components,
templates, and other resources to help you create products
for Firefox users.

Another feature that is deeply integrated into Firefox
57 is Pocket. While not necessarily a brand new
feature – we’ve seen Pocket in the past several
Firefox releases – Pocket takes on an expanded
role. It will now recommend trending articles for you
to read. Beginning life as a Firefox add-on, Pocket
serves as a sort of read-it-later-DVR for the web. If
you see something you want to read, but don’t have
time at the moment, just put it in your Pocket. Then,
you can go back and read it later, when you have
more time. Mozilla liked the Pocket add-on so much
that they purchased Pocket (their first acquisition) for
an undisclosed sum in February 2017.

chance to edit the saved bookmark. If the page
you’re on is not already in your bookmarks, you are
given the chance to add a bookmark to the page.
You can also save the page to Pocket, for reading
later. There are also options to copy the link to the
page, email the link with your default email handler,
send the tab to another synced device, or take a
screenshot.

The “three dot” menu at the end of the address bar
has lots of new features. If the page you’re on is
already in your bookmarks, you are given the
It’s the latter option – Take a Screenshot – that gives
you a lot of options that might not be quickly
apparent. But once you use it, the actions and
options are very easy to use and very user friendly.
Drag your mouse around the screen, and you will
have the ability to select any element of a web page
to save to an image file. Once selected, you can
resize the image capture zone, useful if you aren’t
given the option you are looking for. You can also
save just the visible area that’s currently on your
screen, or you can save the entire web page.
The “hamburger” menu, found in the upper right
corner of Firefox’s window, has been trimmed down.
Here you will find many of the settings that everyday
users will need to access. By the way, don’t worry …

PCLinuxOS Magazine
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experience to some degree by changing the
“Performance” settings. Click on the “hamburger”
menu in the upper right corner of the window, and
select “Preferences.” Under the “General” section,
scroll down to the “Performance” section. The
default setting on my computer – an eight year old
dual core Intel processor with 3GB RAM – limits
threads to just one. Unchecking the “Use
recommended performance settings” allows me to
increase the threads to three. Choices range from
one thread to seven threads.
Use caution here, because you could cause a
negative impact on your overall system. While you
may be tempted to increase the “Content process
limit” to the maximum seven threads, which causes
Firefox 57 to use more memory as you improve
“performance” (read speed). If you have memory to
spare, go ahead and increase to the maximum of
seven threads. But, if you have limited memory,
increasing to the maximum will also increase Firefox
57’s memory footprint. As a result, you will cause
your overall system to increasingly use your swap
partition, which will severely slow your overall
system. So, this is why I have chosen to only
increase the “Content process limit” to only a setting
of three. Try different settings on your system and
see which setting gives you the best performance
with acceptable memory usage.

When you select “Customize… ” from the
“hamburger” menu, you will see something like the
image on the next page. You can further customize
your Firefox experience by dragging and changing
the order of the icons on your toolbar. You can also
drag unwanted icons on the toolbar back to the
middle left portion of the window, or add new tools to
the toolbar from the middle left portion of the window
to where you want them to appear on the toolbar.
At the bottom left of the Firefox window are three
buttons labeled “Toolbars,” “Theme,” and “Density.”
By clicking on the “Toolbars” button, you can toggle
the “Menu Bar” and “Bookmarks Toolbar,” which are
both turned off by default. Turning them both on, in
my opinion, gives Firefox 57 the familiar appearance
that I’ve become accustomed to seeing in Firefox
over the years, as well as access to two items that I
regularly use.
The “Theme” button allows you to quickly change
the theme that Firefox uses to draw its appearance.
By default, you will be able to choose between
Default, Light or Dark. If you’ve downloaded other
compatible themes, they will also show up as
selections. Plus, Firefox will show you a few
“recommended” themes you might want to explore.
The “Density” button allows you to keep the default
item spacing, wider spacing for touchscreens, or a
compact spacing that helps free up a little more

the about:config and about:addons pages are still
available for full access to all settings.
Under the hood, Firefox 57 now is a multithreaded
program that will also leverage multiple cores on
your CPU. This is an obvious contributor to Firefox
57’s speed increase. You can tailor your Firefox 57
PCLinuxOS Magazine
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* Middle mouse paste in the content area no longer
navigates to URLs by default on Unix systems.
* Removed the toolbar Share button. If you relied on
this feature, you can install the Share Backported
extension instead.
* AMD VP9 hardware video decoder support for
improved video playback with lower power
consumption.
* Accessibility indicator will now appear in the title
bar of the window when Accessibility services are
enabled.
* Firefox 57 ships without a visible search bar in the
interface. You
can
enable
it
under
about:preferences#search on new installations. Old
installations should not be affected by this.

Not Everyone Is Happy
royally screw things up, you can quickly reset Firefox
57 to its default configuration by selecting the
“Restore Defaults” button.
Here are a few other things that have changed with
Firefox 57:

space. I prefer the compact setting, but not everyone
will have the same views, so they can tailor it to their
own tastes.
At the lower right corner of the configuration window,
you can select the “Done” button when you have
everything configured the way you want. Or, if you
PCLinuxOS Magazine

* The browser's auto scroll feature, as well as
scrolling by keyboard input and touch-dragging of
scrollbars, now use asynchronous scrolling. These
scrolling methods are now similar to other input
methods like mousewheel, and provide a smoother
scrolling experience.
* The content process now has a stricter security
sandbox that blocks filesystem reading and writing
on Linux, similar to the protections for Windows and
macOS that shipped in Firefox 56.

There was a major change with Firefox 57 that we
haven’t discussed. Sure, it is faster and leaner, but
that hasn’t made everyone happy. With Firefox 57
comes the end of XUL and XPCOM based add-ons.
Firefox 57 transitions to WebExtensions for all of its
add-ons.
As a result, many old favorite add-ons are no longer
compatible with Firefox 57. Add-on developers have
known that this moment was coming for quite some
time now. Some add-ons just simply hadn’t yet made
the transition to WebExtensions. Other developers
may have abandoned their add-ons, or don’t have
enough interest to rewrite their add-ons using the
new WebExtensions.
However, just as many add-on developers have
made the transition from XPCOM and XUL based
add-ons to ones that use WebExtensions. In fact, I
was surprised when I updated my PCLinuxOS
installation to Firefox 57 by how many of my heavily
used and often relied upon add-ons were available.
Page 8
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After hearing all the hype before the release of
Firefox 57, I truly thought most of my favorite addons were toast.
Firefox 57 wll list your legacy add-ons for you, and
give you a chance to find replacements for them.
Simply enter about:addons on the address bar, and
then select “Legacy Extensions” on the left side of
the screen. As you can see from the screenshot
above, I lost several add-ons in the transition. Some
I rarely used, while there were others I used
frequently.
Here is a list of add-ons that I use that made the
safe transition to Firefox 57:

Active Add-ons
Adblock Plus
Behind The Overlay Revival
(Fennec) Copy Link Text
Forecastfox (fixed)
Google+ Share
HTTPS Everywhere
Remove Anything
Screengrab!
Video DownloadHelper
Disabled Add-ons
404 Bookmarks
EPUB Reader

Form History Control (II)
Ghostery
Personas Plus
Privacy Badger
Reader
Xmarks Bookmark Sync

Minus - Share Simply
New Add-on Bar
NoUn Buttons
Smiley Sidebar
Tabs on Bottom
The Addon Bar (Restored)

Now, here’s the list of add-ons that didn’t make the
transition. While it’s a substantial list, there were
many that I no longer used, and a few that I used
regularly. In fact, I forgot that some of them were
ever installed, since I used them so infrequently.

I highlighted the ones I used frequently in red text. In
fact, Image Zoom has been an extension I’ve used
since it first appeared as a Firefox add-on. For some
of them, I’ve already found replacements, like for
Google +1, which got replaced with Google+ Share.
Tabs on Bottom is no longer needed, thanks to
another method to achieve the same thing without
the memory overhead (see this month’s Tip Top Tips
column, elsewhere in this issue).

CoLT (Replaced with Fennec Copy Link Text)
Add to Search Bar
Autofill Forms
Black Skin
Classic Theme Restorer
DownThemAll!
DownThemAll! Anti-Container
Fasterfox Lite
FireFTP
FireFTP Button
FlashGot
Forecastfox
Google +1
Google Docs Viewer
gtranslate
Image Zoom
Metal Lion Australis Graphite

Admittedly, I do really miss FireFTP, even though I
knew that the developer had/has no plans to
transition the add-on to using WebExtensions. I used
FireFTP religiously to maintain the magazine’s
website. It was so easy to just do everything in my
web browser. Click, click, click, done. But, having the
advanced notice that FireFTP would not be updated
to using WebExtensions, I prepared for FireFTP to
go missing by transitioning to using FileZilla to
maintain the magazine’s website. While FileZilla isn’t
as convenient as using FireFTP, it is slightly faster
than FireFTP.
Clicking on any of the “Find a Replacement” buttons
next to your Legacy add-ons will land you at this
screen, where you can search for a replacement that
uses WebExtensions. This early in the game, you
may or may not be able to find a replacement for
your legacy add-ons. But, I suspect that the new
collection of WebExtension add-ons will grow just as
large as the collections of XPCOM and XUL
extensions did, over time.
You are likely to read information about a special
setting in about:config that re-enables your legacy
add-ons. I don’t recommend doing so, however. By
changing this particular setting, you lose the multiprocess feature that Mozilla has spent so much time

PCLinuxOS Magazine
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“On December 1, Yahoo Holdings and Oath filed a legal
complaint against Mozilla in Santa Clara County court
claiming that we improperly terminated our agreement.
On December 5, Mozilla filed a cross-complaint seeking
to ensure that our rights under our contract with Yahoo
are enforced.
We recently exercised our contractual right to terminate
our agreement with Yahoo based on a number of factors
including doing what’s best for our brand, our effort to
provide quality web search, and the broader content
experience for our users.

implementing and that is largely responsible for
Firefox 57’s speed increase. Plus, there’s no
guarantee that this setting won’t go away in the near
future. Personally, I’ll take the speed increase over
the add-ons. I can usually find other ways to do what
the add-ons did, even if it isn’t as convenient.
I reckon that there are many of us who could truly do
without a beloved add-on. People are, after all,
creatures of habit. They tend to become emotionally
attached to the weirdest things, and resist all efforts
to change. It’s human nature, and it rears its ugly
head more so in some people than others. Plus, if
it’s not available now, check back tomorrow … or
next week … or next month … or next year.
Chances are pretty good that some enterprising
developer will figure out a way to use the new
WebExtensions development environment to give
you exactly what you are seeking. Like I mentioned
earlier, it’s early in the game, and Firefox developers
around the world will need time to adapt – some
more than others – to a new way of doing things.

Connect

All your
PCLinuxOS
connections in one
convenient location!
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Believe it or not … legal wranglings
With Firefox 57, Mozilla switched from using Yahoo!
as its default search engine, back to using Google.
In 2014, Mozilla entered into a five year contract with
Yahoo! to make Yahoo! the default search engine for
users in the United States. In the interim, Yahoo! and
AOL were acquired by Verizon, under an umbrella
company called Oath.
Mozilla entered a several month long discussion with
Oath to insure that the provisions of the 2014
contract were going to be upheld and honored.
Furthermore, users felt betrayed by Mozilla’s
promotion of the Yahoo! search engine to the default
status, feeling as if Mozilla no longer had the users’
best interests in mind.
As a result, Yahoo! filed suit on December 1, 2017,
claiming that Mozilla had improperly terminated the
agreement between Mozilla and Yahoo!. On
December 5, 2017, Mozilla countersued Yahoo! and
Oath for breach of contract.
Here is Mozilla’s official statement concerning what
happened:

Immediately following Yahoo’s acquisition, we undertook
a lengthy, multi-month process to seek assurances from
Yahoo and its acquirers with respect to those factors.
When it became clear that continuing to use Yahoo as our
default search provider would have a negative impact on
all of the above, we exercised our contractual right to
terminate the agreement and entered into an agreement
with another provider.
The terms of our contract are clear and our posttermination rights under our contract with Yahoo should
continue to be enforced. We enter into all of our
relationships with a shared goal to deliver a great user
experience and further the web as an open platform. No
relationship should end this way – litigation doesn’t
further any goals for the ecosystem. Still, we are proud of
how we conducted our business and product work
throughout the relationship, how we handled the
termination of the agreement, and we are confident in our
legal positions.
We remain focused on the recent launch of Firefox
Quantum and our commitment to protecting the internet
as a global public resource, especially at a time when
user rights like net neutrality and privacy are under
attack.”

Even though quite a bit of the legal wranglings are
confidential, you can follow along as Mozilla tries to
maintain full openness and transparency through
this process. They have set up a Wiki page with links
to relevant public court documents.
Page 10
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Summary

writing this article, and I never experienced a slow
down. Unlike Firefox 56, Firefox Quantum was very
well behaved.
Is it perfect? Nope, but then if it ever did achieve
perfection, there’d be no reason for upgrades and
updates. The game would be over. That is unlikely to
happen, since there are as many ideas of what
represents “perfection” as there are people willing to

give their opinion. And, we all know that you can
never make some people happy, no matter what.

Linux Docs
Linux Man Pages

Screenshot Showcase

If you used Firefox in the past, you owe it to yourself
to give it another look. With Firefox Quantum, it has
slimmed way down and REALLY sped up!
As what happens any time technology surges
forward, some people are bound to have some
apprehension about the changes that Firefox
Quantum brings to the table.
Fast? You betcha! Firefox has once again regained
its rank as my go-to browser. Call me a Firefox
diehard, if you want. But Google Chrome is a
resource and memory hog on any computer I have
run it on (and I’ve given it many, many chances).
Slimjet just doesn’t get it done, for me, with page
loads nearly as slow as Google Chrome and nearly
as resource/memory hungry. Opera remains a good
alternative, in my opinion, but it is different in many
aspects.
I have to add that Firefox Quantum is very, very
stable. At one point, I had 25 tabs opened up while
PCLinuxOS Magazine

Posted by zen-subz on December 3, 2017, running Mate.
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How To Customize The Firefox 57 User Interface
by M. Hanny Sabbagh
The FOSS Post
https://fosspost.org/tutorials/how-to-customize-firefox-57-user-interface
Reprinted under CC BY-NC-SA 4.0 license.
The new Firefox Quantum browser from Mozilla brought tons of new features and
updates. It is now faster, lighter and more organized than ever it was before.
However, with the new Firefox Quantum technologies which detached the older
APIs used for complete themes and other add-ons, users were having a hard
time customizing the browser’s interface.
Fortunately, you can easily customize Firefox 57 interface by modifying the
default “skin.” You can simply create a bunch of CSS rules which change the
Firefox interface however you like. We’ll learn together how to do it in this tutorial.

Step 1: Locate your userChrome.css File
userChrome.css is the file which you’ll be using to store your CSS rules related
to Firefox skin. This file should be inside a folder called chrome in your default
Firefox profile. Usually, both the folder and the file don’t exist by default, but we
can create them.

PCLinuxOS Magazine

To make it easy on you, open the Firefox main menu and go to Help –>
Troubleshooting Information. Under Profile Directory click the “Open Directory”
button. Which should open the folder of your current Firefox profile (previous
image).
Now, create a folder called chrome, and inside that folder, create an empty file
called userChrome.css . You can now start putting all the CSS rules you want in
that file and they will be automatically loaded by Firefox when it starts (if you
modify the file, you have to restart Firefox).

Step 2: Enable Browser Toolbox
In order to write CSS rules related to Firefox interface, you need to know the
available CSS selectors that you can use. For example, can we use #tab-bar to
modify the CSS of the Firefox tab bar? What possible selectors are there? That’s
why you need to enable an option called “Browser Toolbox”.
To do this, open the “Inspect Element” option from the context menu (right click
anywhere on any opened web page), and open settings like the following:
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Scroll down to “Advanced options” and check both the “Enable browser chrome
and add-on debugging toolboxes” and “Enable remote debugging” options as you
can see in the picture:

Click on the inspector button (the first button on the left) in order to be able to
inspect elements by your mouse:
Now open the browser toolbox from Web Developer –> Browser Toolbox. A
confirmation message like this will appear, then hit OK:

After that, you can put your mouse pointer on any place in your browser window
in order to learn its unique ID. For example, if you put it on the navigation bar,
you’ll see a red dotted line around it:

Finally, the browser toolbox window should appear, which you can use to analyze
the structure of Firefox interface:
PCLinuxOS Magazine
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Notice the id=”nav-bar” CSS selector in the code. It means that you can use
#nav-bar in your userChrome.css file to modify the look of the navigation bar. For
example, say that I want to change the background of the navigation bar into
complete white, what I’ll add in my userChrome.css file is the following:
#nav- bar {
background: #fff ! important;
}

Remember always to use !important in each CSS rule you create in order to
overwrite the default Firefox skin rules. Otherwise, you may go crazy about why
your CSS is not being applied. Also don’t forget to restart Firefox after each
modification you do.
After restarting Firefox, this is what I’ll get:

I would recommend installing the Tab Center Redux extension which creates a
sidebar for your opened tabs. After that, you can apply the following CSS rules in
userChrome.css:
#tabbrowser- tabs {
visibility: collapse ! important;
}
#sidebar- box {
overflow: hidden;
min- width: 0px;
max- width: 0px;
position: fixed;
border- right: 1px solid #eee;
transition: all 0. 2s ease;
z- index: 2;
}
#sidebar- box: hover,
#sidebar- box #sidebar {
min- width: 200px ! important;
max- width: 200px ! important;
}
#sidebar- box #sidebar- header, #sidebar- box ~ #sidebar- splitter {
display: none;
}
#sidebar- box #sidebar {
height: 100vh;
}
#urlbar {
border- radius: 0px ! important;
}

And here’s how your browser will look like:

Step 3: Start Playing
You now know how to create the CSS rules you need to customize any part of
your browser. You can change the default skin, or modify the structure of your
browser’s interface however you like.

PCLinuxOS Magazine
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Your tabs will be auto-hidden on the left side:

If you want always to see the tab bar on the left, then just replace the #sidebarbox part of the code with following code snippet:
#sidebar- box {
overflow: hidden;
min- width: 32px;
max- width: 32px;
position: fixed;
border- right: 1px solid #eee;
transition: all 0. 2s ease;
z- index: 2;
}
#appcontent {
margin- left: 32px;
}

And you’ll get a better view (image at top of next column).
The following list of selectors for Firefox CSS should get you going:

#appcontent: The web view of Firefox (the web page itself).

#identity-box: The small area in the left side of the URL bar which contains the
information & connection icons.
#sidebar-box: The sidebar tab bar provided by the “Tab Center Redux”
extension.
#back-button: Get back button in the navigation bar.
#forward-button: The forward button.
#reload-button: The reload button.
#home-button: The home button.
#downloads-button: The downloads button.
#PanelUI-menu-button: The main Firefox menubar button.
You can explore the rest of available selectors from the way we explained in the
first step. Feel free to apply whatever CSS styles you want to get the look & feel
you enjoy the most.

#tabbrowser-tabs: The tab bar at the top of Firefox.
#urlbar: The URL bar in the navigation bar.
PCLinuxOS Magazine
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Conclusion
Although we lost the complete Firefox themes in
Firefox 57, we still can customize the UI of Firefox to
a very good level. In the future, we may be able to
install ready themes which include ready
userChrome.css modifications to customize Firefox
in many different ways and combinations.
If you have any specific tip or skin you made related
to that, feel free to share them with us.

Donate To PCLinuxOS
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ms_meme's Nook: PCLOS Chant
There's a funny little honey down in Texas
Made a sunny little forum for his OS
Fans gathered there every day
Tex would give his OS away
About it ms_meme started chanting it
Then Meemaw started dancing it
In the Sandbox that's now the way of it
All the world has the benefit of it
PCLinuxOS
Some say it started down in Arkansas
It's as popular in Utah or Omaha
Grandma and grandpa chant hurrah for it
All the world is in awe of it

MP3
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Though it started down in Arkansas
It's as popular in Osaka or Panama
Grandma and grandpa chant hurrah for it
All the world is in awe of it
PCLinuxOS

OGG
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GIMP Tutorial: Create A Color Swirl
by Meemaw
I found a neat tutorial that only takes a few steps
and makes a swirl pattern that could be used for a
wallpaper or a fun background. I think it will be fun.

Duplicate the layer, naming the original one name
“fade black”. For this layer, set the layer mode to
Multiply. Rename the duplicate “light”.

Create a new image. I made mine 640×480, but you
can use any size. Choose Filter > Render > Clouds
> Plasma. You can change the pattern by clicking on
the New Seed button. When you get something you
like, apply the filter. Your result should look similar to
the image at center, top:
Now do Filters > Distorts > Whirl and Pinch , using
the following settings:
Whirl angle: 130
Pinch amount: 1
Radius: 1
It should look like this now (right).
Create a new transparent layer.
PCLinuxOS Magazine

Choose the Blend tool, using white as foreground
color and black as background color and choosing
the shape: Radial .
Click and hold the mouse button and move from the
center of the image to one of the four corners. It
should now look like this (top, right):

Click the layer named light. Choosing Colors >
Brightness & Contrast, change the values to -65
(brightness) and +45 (contrast). Now apply Filters >
Distorts > Whirl and Pinch , using the following
settings:
Whirl angle: 130
Pinch amount: 0.8
Radius: 1
Set the layer mode for this layer to Dodge. Duplicate
the light layer to enhance the effect.
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Color balance. Using Color Balance, you might try
the following settings:
Shadows -30 / -30 / +30
Mids: -30 / +10 / 0
Highlights: 0 / 0 / 30

You can also leave out the black or white
background and make it semi-transparent, then use
it as an accent on something else, like a real quick
letterhead:

You can even make a wallpaper. I like mine a bit
darker, so I kept the black.

Now change to the background layer. Choose Filter
> Blur > Selective Gaussian Blur with the following
settings:
Radius: 50
Max. Delta: 70
You can export your project any time you are
satisfied with it. I chose to save it with the black
around the outside, but I also used Colors > Color
to Alpha and remove the black, then put a white
background behind it. I got this:

As always, you can get several effects, depending
on your settings. Hope you had a bit of fun with this
experiment!
Looking for an old article?
Can't find what you want? Try the

I actually liked it better before the blur, so I’m going
to undo that and leave it without the blur.

PCLinuxOS Magazine's
searchable index!

You could make it a single color using Colors >
Desaturate, then Colors > Colorize or Colors >
PCLinuxOS Magazine
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SplashData's 100 Worst Passwords Of 2017
by Paul Arnote (parnote)

If a password you use is in this list below, you might
want to consider changing it. You obviously weren’t
as original as you should be.
Editor’s Note: Some of the passwords are what many
would call profanity, so the list shouldn’t be considered
“family friendly.” However, they are included here for the
sake of completeness and factual reporting. For the
naughty words in the list, highlight the text after the
number to see the word.

Photo: Santeri Viinamäki, Wikimedia Commons. Creative
Commons Attribution-Share Alike 4.0 International
license.

On December 19, 2017, SplashData released its list
of the 100 worst passwords of 2017. People never
seem to learn, since there are many perennial
favorites on this list. SplashData, who sells
password management software, has compiled the
list of poor passwords since 2010. The data is
gleaned from information gathered from the many
data breaches of personal information that occurred
over the past year.
So, before we talk about much else, here is the list.
Among the first 25 passwords, a number after the
password represents the number of positions of
change from the 2016 worst password list. If a
password is new to the list, it will be denoted as
“new” instead of a number. Similarly, passwords in
the list that haven’t changed positions from 2016 will
be denoted as “unchanged.”
PCLinuxOS Magazine

1. 123456 (unchanged)
2. password (unchanged)
3. 12345678 (+1)
4. qwerty (+2)
5. 12345 (-2)
6. 123456789 (New)
7. letmein (New)
8. 1234567 (unchanged)
9. football (-4)
10. iloveyou (New)
11. admin (+4)
12. welcome (unchanged)
13. monkey (New)
14. login (-3)
15. abc123 (-1)
16. starwars (New)
17. 123123 (New)
18. dragon (+1)
19. passw0rd (-1)
20. master (+1)
21. hello (New)
22. freedom (New)
23. whatever (New)
24. qazwsx (New)
25. trustno1 (New)
26. 654321
27. jordan23
28. harley
29. password1

30. 1234
31. robert
32. matthew
33. jordan
34. asshole
35. daniel
36. andrew
37. lakers
38. andrea
39. buster
40. joshua
41. 1qaz2wsx
42. 12341234
43. ferrari
44. cheese
45. computer
46. corvette
47. blahblah
48. george
49. mercedes
50. 121212
51. maverick
52. fuckyou
53. nicole
54. hunter
55. sunshine
56. tigger
57. 1989
58. merlin
59. ranger
60. solo
61. banana
62. chelsea
63. summer
64. 1990
65. 1991
66. phoenix
67. amanda
68. cookie
69. ashley
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70. bandit
71. killer
72. aaaaaa
73. pepper
74. jessica
75. zaq1zaq1
76. jennifer
77. test
78. hockey
79. dallas
80. passwor
81. michelle
82. admin123
83. pussy
84. pass
85. asdf
86. william
87. soccer
88. london
89. 1q2w3e
90. 1992
91. biteme
92. maggie
93. querty
94. rangers
95. charlie
96. martin
97. ginger
98. golfer
99. yankees
100. thunder

passwords as “trustno1” and “freedom”. Still popular
are keyboard patterns, such as the “1qaz2wsx” and
“qwerty” passwords.

Best Practice: What Makes A Good Password
In years past, we thought this was an easy one to
answer. But in August, 2017, Bill Burr set the
password world on its ear. See, Bill Burr was the
employee of the National Institute of Standards and

Technology who released a report in 2003
advocating for the use of special characters, mixed
case letters, and numbers in a password in the
hopes of fooling/foiling hackers. Literally overnight,
his paper became password policy. It became the
FINAL WORD on passwords. (Read the full USA
Today article here.)
But in August, Bill Burr stated in a Wall Street
Journal article, “Much of what I did, I regret.” His
report wasn’t based on any real-world password

Of course, the perennial favorites still top the list,
where they’ve stayed for some time. Both “123456”
and “password” have been at or near the top of the
list ever since the list has been compiled. Passwords
related to sports (“soccer” or “football”) or favorite
sports teams (“lakers” or “rangers” or “yankees”)
remain popular. This year, probably because of the
new Star Wars movies coming out to a whole new
generation of Star Wars fans, “starwars” as a
password cracks the top 20 worst passwords. The
“rage against the machine” is evident, with
passwords such as “letmein” and “biteme”. The
rising political division is also evident, with such
PCLinuxOS Magazine

Page 22

SplashData's 100 Worst Passwords Of 2017
experience or expertise. Rather, it was based on
another paper written in the 1980s. But in the
interim, it became entrenched as THE holy
password gospel.
Bill Burr now suggests that users string together four
common and random words, instead of the
“standard” mix of uppercase and lowercase letters,
numbers, and special characters. The XKCD comic
shown here (previous page) sums up nicely why and
how this is better.
But don’t expect to see websites and other entities
jump aboard with this new revelation, as many of
them will still require the “standard” mix from that
2003 report that has become password gospel.
Those “recommendations” are firmly entrenched in
the password world as key tenets of the “religion.”
After all, it took us nearly 20 years to get to that
point, and it’s likely to take twice as long (or more)
for those erroneous thoughts to erode, despite
evidence that there is a better way. So many bad
ideas take so long to go away.
Still, it’s apparent that many users are sloppy with
passwords. This is evident from the 2017 Worst
Passwords list. So, there are ways to help protect
yourself with strong passwords. The fact remains
that there is no uncrackable password, given
enough time. But the goal is to make it sufficiently
difficult to crack that the hackers will simply give up
and move on to the next poor sucker in line, leaving
your data safe. Who knows? Maybe the next poor
sucker has a password that is on this worst
password list.

Use a password manager. What to use depends
on whether you trust the cloud or not, and what level
of convenience you are seeking. If you want to use
the same password manager on several devices
(and who doesn’t use multiple devices these days),
then a cloud based solution is what you need.
Probably the premiere service is LastPass, a web
browser plugin. It will remember all of your
passwords for your websites that require them, and
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help generate secure random passwords for new
websites. All you have to remember is your “master”
password. Don’t get amnesia, because if you forget
your “master” password, even the folks at LastPass
can’t retrieve your passwords without it. They most
likely can’t/won’t be able to retrieve your passwords
WITH your master password, either.

Similarly, avoid personal “treasures.” This means
avoid using birth dates, wedding dates, anniversary
dates, address, names of children, names of pets,
names of favorite foods, and anything else that is
either common knowledge or easily ascertained
knowledge about you.

If a local, non-cloud solution is more to your liking,
you can install KeepassX, which is in the
PCLinuxOS repository. It works much like LastPass,
but without the cloud part. Your passwords are
saved in an encrypted file on your hard drive.

Summary

There are other password managers out there. So, if
either of these aren’t necessarily what you’re looking
for, give one of the others a try. Just be careful about
where you place your trust.

Don’t use the same password on multiple
websites. This should be a no-brainer, but it
happens all the time, many times a day, all over the
world. First, humans are creatures of habit. Second,
it’s much “easier” to remember one or two
passwords that you use all over the web. Of course,
easier for you also grants easier access to your
personal data – for the hackers (if I have to explain
this, then you really haven’t given the security of
your data much thought at all). If the hackers get
ahold of one of your passwords, they will attempt to
use it at other sites. Make your passwords unique
for each site (which makes using the
aforementioned password manager even sweeter
and more desirable).

It does seem that data breaches are occurring at an
ever increasing rate. In fact, data breaches are
becoming all too common. This is understandable,
since YOUR personal data is the currency d’jour for
hackers and other unscrupulous folk, as well as
various governments around the world. Some of the
more common companies that experienced data
breaches just in 2017 include Verizon, Saks Fifth
Avenue, Deloitte, and Uber. Let’s not forget about
the huge Equifax breach that exposed the personal
information of millions of people. The statistics
concerning data breaches don’t include the
perennial sieve called Yahoo!, or adult websites.
YOU are the only person who actually cares enough
about your data to keep it protected. Despite their
attempts to convince you otherwise, companies true
loyalty is to their bottom line and their stockholders.
That protection of your personal data should – and
does – start and stop with YOU. If you’re sloppy with
your passwords (weak, ineffective passwords,
reused everywhere), you will eventually reap what
you sow. You likely will not like the bitter crop that
results.

Avoid pop culture and personal “treasures.” Pop
culture words, like your favorite sport, sport team,
movie, movie character, actor/actress, etc., will
always be popular choices when you’re trying to pick
a password that reflects your tastes and “inner you.”
Avoid them, because you’re likely not the only fan
who has chosen to use that pop culture word or
phrase. If you were, it wouldn’t be pop culture.
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PCLinuxOS Recipe Corner

Enfrijoladas Bake
Ingredients:
1 can (16 oz) refried beans
1 can (4.5 oz) chopped green chiles
1 cup Thick ‘n Chunky salsa (any variety)
2 cups finely shredded Mexican cheese blend (8 oz)
1 package (8.2 oz) flour tortillas for soft tacos &
fajitas (6 inches)

Tips:
Try these toppings: fresh cilantro leaves, green
onions, sour cream, jalapeños, sliced avocados.

Steps:
1 Heat oven to 400F. Spray 13x9-inch (3-quart)
glass baking dish or pan with cooking spray.
2 In blender, add beans, chiles and salsa. Cover;
blend 30 seconds to 1 minute or until smooth. Pour
bean sauce into 9-inch glass pie plate.
3 Using tongs, dip both sides of tortilla into sauce.
Place in baking dish, and sprinkle 2 tablespoons
cheese in center; fold in half, then in half again.
Repeat with remaining tortillas, overlapping in dish.
Pour remaining sauce over tortillas; sprinkle with
remaining cheese.
4 Bake 12 to 16 minutes or until hot and cheese is
melted. Serve with Make it FRESH toppings.
PCLinuxOS Magazine
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For Those Who Do Not Like The New Firefox 57
by Alessandro Ebersol (Agent Smith)

corporation, which was the one that managed the
commercial links of the foundation), were aimed at
making Firefox OS a top contender among the
various mobile OSes that existed then.
Not only Firefox OS, but Mozilla was committed to
high quality game development with HTML5 (Unreal
Engine, Monster Madness) and Javascript (asm.js),
was betting big on WebRTC, as a new standard for
online communication (bye bye Skype). And thanks
to a well optimized and light code, Firefox OS could
run on low end mobile phones without problems.

Our dear Chief Editor Paul Arnote wrote an article
praising the qualities of the new Firefox, how it is
better than it has ever been, and how many users
are surprised and fascinated by the new Firefox
Quantum.
However, I decided to play devil's advocate here,
because the new Firefox did not surprise me that
much, and despite being much faster, smaller and
lighter, appearances can be deceiving. All these
qualities are only superficial, since the "new" Firefox
abandoned many features that were unique.
The first casualties were the add-ons, and if you had
some particular addon, needed or used on a daily
basis, not being able to use it anymore is very
annoying. But I’ll get back to this subject in a
moment. First, let's look at the past of Firefox,
precisely five years ago, when Firefox was surfing a
wave of unprecedented success.

Firefox in 2013
In 2013, Firefox was at the top of the world. The
Mozilla Foundation had launched Firefox OS, and
the whole entity (the foundation plus the Mozilla
PCLinuxOS Magazine

Mozilla was aiming at emerging markets where
smart phones were luxury goods. Thus, it reached
agreements in countries such as Uruguay, India,
Bangladesh, Panama, El Salvador, Nicaragua and
Poland, among others.
There was excitement and anticipation, at every
Mozilla's announcement, referring to the Firefox OS.
The system was very similar to Android, because it
had a Linux kernel, a hardware abstraction layer
(HAL) Gonk, Gecko, which was the browser engine
of the Firefox operating system, responsible for
rendering the HTML, CSS
and JavaScript. Gecko
included a network stack, a
stack for graphics, a layout
engine, a virtual machine (for
JavaScript execution) and a
layer of portability, and Gaia,
the system's user interface.
Because of its simplicity, it
was appropriate for native
web applications, and all the
apps it had were based on
HTML5 + JavaScript and
CSS.
The Firefox OS had an elegant
interface

But in 2014, everything would change, and I think,
for the worse.

Brendan Eich, the visionary who wanted to do an
online revolution
Brendan Eich was one of Netscape's employees
who helped create the Javascript language in 1995.
In early 1998, Eich co-founded the Mozilla project
with Mitchell Baker, creating the site Mozilla.org,
which should manage all open source contributions
to the Netscape source code. He served as the chief
architect of Mozilla. After AOL bought Netscape and
pulled the plug on the project, he helped in the
creation of the Mozilla Foundation.

Eich in an official photo from 2012

He ascended several steps in the organization,
serving as CTO from 2005, and being appointed as
CEO in March 2014. However, his appointment did
not please some members, who left the board of
directors of Mozilla foundation after Eich has taken
the position. But things did not stop there, and
escalated quickly to a very embarrassing outcome.
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Some employees of the Mozilla Foundation (a
separate organization from the Mozilla Corporation,
which as I mentioned earlier, is the commercial arm
of the entity) requested his resignation, based on his
donation of $1,000 for Proposition 8 in California.
This banned same sex marriage in California, before
being overthrown in 2013, when it was declared
unconstitutional and same sex marriages were
allowed again. Eich stood by his decision to finance
the campaign, but wrote in his blog that he was sorry
for "the pain he caused" and promised to promote
equality in Mozilla. Some of the activists even
created an online shaming campaign against Eich,
with the online dating site OkCupid automatically
displaying a message to Firefox users, complete
with information about Eich’s donation and
suggesting that users move to a different browser.
Other Mozilla Corporation people spoke on their
blogs in favor of Eich. Board members wanted him
to remain in the company in a different position. On
April 3rd, 2014, Eich resigned as CEO and resigned
altogether from Mozilla. In his personal blog, Eich
posted that "in the present circumstances, I can not
be an effective leader."
Eich, as one of the creators of JavaScript, wanted to
make Firefox a new force on the web, especially with
the appeal of web applications running on Firefox
OS for mobile phones worldwide. And one very
important detail: He was against the adoption of
EME's (encrypted multimedia extensions) as a
standard in HTML5. He wanted a free web for users,
not a locked web by DRM schemes.

Eich fell, and Firefox started to go downhill
With the whole campaign against him, Eich had no
choice but to leave Mozilla Foundation. But Eich’s
departure affected the development of Firefox and
Mozilla, deeper than anyone could anticipate.

another project that languished slowly to death, and
the dominant companies in the mobile market
(Apple, Google and Microsoft to a lesser extent)
were not sad about it. It was one less competitor out
of the match.
So he was struck at first by "friendly fire" from within
the Mozilla Foundation, and opposition to him
increased to a level that he could not resist.
However, many speculated that it was not because
of his political views, but because he was opposed
to DRM in Firefox and was a force to push forward
the Firefox OS in the mobile market.
And the decline was so great that Firefox was called
the walking dead browser.

Firefox Quantum is the new attempt by Mozilla to
be the number 1
With the release of version 57, Quantum, Mozilla
tries again be the premiere web browser, and its
features are really impressive: New rendering
engine, written in Rust, able to use multiprocessing
to accelerate loading and rendering of web pages, in
addition to its optimized code to consume less
memory (30% less, say the technicians at Mozilla), a
new interface (Photon) and Google returned as the
default search for different Western countries
(Yandex remains in Russia and Baidu is still default
in China), this new Firefox ended up with all the old
extensions.

The new add-ons system, the WebExtensions API,
retired all extensions/add-ons prior to version 57. As
the browser pulled the plug on XUL (XML User
Interface Language) to only support extensions
developed by WebExtensions API, many popular
extensions do not work anymore until its developers
port them to the new API.
Now, basic add-ons, such as Down Them All, and
many others simply stopped working. I think, by the
time this article comes out, perhaps these add-ons
might have been ported, but what if not?
For those who work with Firefox, it was a very hard
blow. After all, extensions like Firebug, Web
Developer and X-Ray are essential, and may not be
ported.
And in these times of leaking passwords and
exposed profiles on the Internet, Mozilla did a promo
stunt for the Mr. Robot series, installed an extension,
Looking Glass, without the consent of users, and the
internet caught fire. "If Mozilla is positioned as a
conscious privacy alternative to Google, Microsoft
and others, then install an extension without asking
the user first, it does not feel right" - Techcrunch
On the other hand, for us Linux users, the
dependence of Pulseaudio is something detestable.

But fear not: There are alternatives
And after all this introduction, we get to the feasible
alternatives to Firefox. All those who liked the old
Firefox, can have the pleasure to use again all the
add-ons and extensions that made Firefox so good.
Besides, the old Firefox had great ideas, and some
were abandoned along the way (such as the Tab
Groups button in FF 45).

With him out of the way, Firefox embraced DRM
technology for web content, which was lobbied for
by Netflix and other companies. Firefox OS was also
PCLinuxOS Magazine
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Palemoon
Pale Moon is an open source web browser with an
emphasis on customization. Its motto is "Your
browser, your way." There are official releases for
Microsoft Windows and Linux, an unofficial
compilation for MacOS, and several versions made
by volunteers for various platforms.

• Default search engine is DuckDuckGo instead of
Google or Yahoo!
• It uses the IP-API service instead of Google for
geolocation.
• Support for a growing number of unique
extensions for Pale Moon
• Comprehensive and growing support for HTML5
and CSS3
• General support for image formats: supports
WebP and JPEG-XR
• Supports Tab Groups (natively, only Tab Button, an
extension has to be installed for the group tabs)
• Does not use Pulseaudio to play media on Linux
• Is much smaller than Firefox (just 36MB), and is
faster than the previous versions to version 57 of
Firefox.
With a fully customizable interface and support to
Firefox add-ons, it is a great option.

Waterfox
Pale Moon is a Firefox fork with substantial
differences, especially for add-ons and user
interface. In particular, Pale Moon continues to
support the XUL and XPCOM resources that Firefox
removed in version 57. Pale Moon also kept the fully
customizable user interface of Firefox 4-28, while
upgrading other parts of the browser with the new
code source from Firefox.

Features:
• Replaces the Gecko engine with the fork Goanna
• Uses the pre-Australis interface of Firefox
• Continues the support for XUL plugins, XPCOM
and NPAPI
• Supports exclusive extensions and themes for
Pale Moon, as Adblock Latitude
• Presets for a home page customizable in
cooperation with start.me
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Waterfox is an open-source web browser for 64-bit
operating systems, with an aim to be speedy and
ethical. There are official releases for 64-bit
Windows (including a portable version), MacOS, 64bit Linux, and 64-bit Android. Waterfox is based on
Firefox and is compiled using different compilers and
utilizes Intel’s Math Kernel Library, Streaming SIMD
Extensions 3 and Advanced Vector Extensions. The
Linux builds are created with Clang. Waterfox will
continue to support the long-standing XUL and
XPCOM add-on capability that Firefox removed in
version 57.
The Waterfox browser was initiated in March 2011
by Alex Kontos, a 16 year old student.
The Waterfox browser was one of the first 64-bit
browsers widely distributed on the web and quickly
gained a loyal following. At one point, Waterfox had
a sole objective: speed. But now Waterfox also tries
to be an ethical browser and oriented to the user.

Features:
• Disables Encrypted Media Extensions (EME)
• Disables Web Runtime
• Removed Adobe DRM
• Removed the Pocket feature
• Removed Telemetry
• Removes data collection
• Removes the boot profile
• Allows the operation of all 64-bit NPAPI plugins
• Allows unsigned extensions to run
• Removes sponsored tabs on opening new pages
• Added option to duplicate tabs
• Added locales selector in about: preferences >
General
• Default search engine Ecosia instead of Google
or Yahoo!
• Does not use Pulseaudio to play media on Linux
Waterfox is quite impressive. It is like a Firefox 55
with very good features, and the author picks the
latest improvements in the Firefox code without
getting into conflicting situations regarding the
privacy of users or the use of DRM features, which
limit the free internet.

Verdict
It is very interesting to see that the legacy of Firefox
lives on. In fact, one of the many advantages of free
Page 28
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software is the freedom of forking it when it is not
considered satisfying anymore. Sadly, Firefox 57,
through its changes and many new features, is no
longer the preferred browser of many people
(including me). Mozilla is playing to the audience,
but the audience of Windows and Mac, hardly for the
Linux audience. And now they seem concerned only
with gaining Google Chrome’s market share and
ignoring the very reason that made Firefox’s
inception, back in ‘98.
But to everyone who stopped liking Firefox, there
are options. And high-quality options.

It's easier than E=mc2
It's elemental
It's light years ahead
It's a wise choice
It's Radically Simple
It's ...
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Posted by tbschommer on December 11, 2017, running KDE.

Page 29

PCLinuxOS Family Member Spotlight: StarBaseONE2
As told to YouCanToo

Are you retired, still working and if working, what
do you do?
I was forced into retirement almost 5 years ago now.
I have some medical issues that complicate life
sometimes. I still tinker though. I have an electronics
workshop here on the farm. I spend a few hours a
day out there tinkering, or out riding my bike as my
health allows.
Where do you call home? What is it like? IE:
weather, scenery
A little place called Prospect, Tennessee is where we
live. I live atop a fair sized hill just north of Kedron
community, as such, I call this hill Kedron Hill. I don't
think it has a name for the folks around me though.

What is your name/username?
My name is Robert Amerson. I go by my 'handle' of
StarBaseONE2 almost everywhere online. I took
that name from the name I gave my old Base-radio
rig way back in the day.
How old are you?
I am just getting into my 60's. No wonder I am
feeling old.
Are you married, single?
I am blessed man, blessed to be married to the
luckiest lady in South-Central Tennessee. She was
my high school sweetheart, and we have always
been an item. We didn't marry right away, but we
were always talking about it 'someday' in school.
After we got out, we still waited a while. I told her
"Before I say 'I do', I want to know I can." I guess
that took me a few years, but I finally got my head
on straight. And we did get around to it.
That was a long time ago, as we celebrated our
32nd wedding anniversary last July.

How about Kids, Grandkids (names and ages)?
Donna (my wife) and I have two kids. We've been
empty-nesters now for a couple of years. No
grandkids though. I sure would like to see a few
before I get too old.
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Do you have pets, what is your favorite?
Lord do we. I lovingly call them our varmints. We
have two dogs. One is a Blue Heeler mix, and the
other is my favorite. She is a Japanese Akita. She is
a sweetheart, and some kind of protective over me. I
have no idea why she picked me over Donna, as
Donna has always been the 'varmint type,' but she
did. We also have an old ailing calico cat. She's
blind in one eye and has breathing problems. We
simply call her 'Kitty.' She was quite the mouser a
few years back. She has had a rough life, so she
has a special spot in our hearts. Past that, we have
a fair amount (20-25) of free-ranging chickens
always underfoot too, but we don't really consider
them pets.

The weather is usually pretty mild. I sure like it that
way as I get older. But it can get pretty hot for a
week or two, usually about the time July turns into
August. Nice and green with rolling hills and shady
hollows is the typical terrain around these parts. Life
is quiet here. Peaceful. Good place to sit a spell out
under any one of the shade trees here in our little
grove. The house and shop are situated for the
grove to protect them from the mean North wind
when winter wants to take a cold bite. It does a good
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job at it, although some of these trees are old
enough now that there is a danger of them falling in
the storms of spring. We do have a few bad storms
around here each spring. We have our share of the
tornadoes that the Southeast is known for, right here
in these parts. But thankfully for the wife and me,
luck has held and we've not had to experience much
damage from them first hand, as we have never
been hit head on. We sure know folks that have
though, folks that we call friends and some family
too. Everyone breathes a little easier when they hear
thunder off in the distance by the time April gets by.

Where did you go to school and what is your
education level?
Donna and I went to school in Fort Payne, Alabama.
I'm ashamed to say I wasn't much for school back
then. Truth be told, if I hadn't been a reader, I would
have never passed anything. First of every school
year, I would be 'charged up' to attend. For about six
weeks maybe. But during that time, I would have
read all my text books. I relied upon my recollection
of what I had read to pass everything through the
year. I didn't score real high (especially towards the
end of each year), but it was enough to have high C
average. It wasn't until a few years had passed (five
years) after high school graduation, that I realized I
had set myself up to be an idiot. And then I got
serious about filling in some gaps and doing
something with the knack I had for circuits. I worked
hard to get where I should have been as I
graduated. I then went off into Army for a while (I
had to prove to myself I was a man). After that, I
went to a trade school and studied electronics, but I
didn't get a job real fast, so I fell into a big truck and
drove west coast turnarounds for a few years. I then
came off the road to work for an electronics repair
service. I did that most of my career, but as in most
things, TV and other consumer electronic repair has
its slumps and runs. During the slumps, I would
learn new skills as we would take in new types of
work. I learned to repair and program the control
boards running the machines working in the local
textile mills. It saved them a lot of downtime by them
getting those boards fixed locally, instead of them
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having to ship them back to Italy to be factory
repaired. Another slump saw me take on Computer
repair. Until then, I had only seen a computer from a
distance, other than the original Commodore we had
at home about the time I was ready try my wings.
Another time we started getting involved with the
very first steps of bringing wireless internet into
NorthEast Alabama using parts of microwave bands
that the FCC was dropping so much of the traditional
restrictive regulations on, so I helped set up some of
the first WiFi towers that went in down that way. After
that, my mother and eldest sister's health moved me
and my family here, and I did go back to school for a
bit at ITT Tech. Honestly, I was a bit disappointed but
I did learn a bit about network security that I had not
picked up on in my employment. It wasn't too long
after that I started having health problems. So yeah,
I spent a bunch of dollars that I will never recoup.
And still I am about as smart as that rock over there.

What kind of things you like doing? hobbies,
travel, fishing, camping?
I have enjoyed camping when I was younger. These
days, I would be so stove up from sleeping like that,
it would take me a week to get over a one night stay
in a tent with a sleeping bag. I tinker on some
electronic repair for friends and family. Mostly guitar
amp repair these days. I can still see most of that
stuff well enough to do some good! I tinker with
repairs on my good days, and I ride my bike. I love
my motorcycle, always have. That would be my
hobby. If I hadn't had Donna happen to me while I
was still a young man, I probably would have wound
up an outlaw biker type.
Why and when did you start using Linux?
When I was a professional repair technician, during
the slower times we would take in some computer
repair work. Honestly, I was not qualified to be doing
that work when it started appearing on my repair
bench. It put me in the books. But I got better, then
one day a Win2K appeared locked down by a
forgotten password. My standard tool I had wouldn't
work, so I had to research it. That lead me to my first
contact with Linux. A fellow technician that was on a

forum site we both were members of recommended I
visit pogostick. I was amazed by this Linux tool! It did
indeed clear that password! In those days you had
to roll your own (compile from source). I had never
attempted anything like that at that time, so it took
me a few tries to get it together. But when I did, I
remember wondering if Bill Gates knew that this
Linux crowd (that we had only had heard the name
of up until then) had a tool that would OWN his
password security. Shortly after that, I got to
following some of the custom driver work for various
WiFi chipsets in the portion of my career I spoke of
earlier. But still I didn't attempt running an OS until
Ubuntu 5, Breezy Badger. Truthfully, it was a
nightmare. I stuck with it though, and got it running
on my little laptop of the time. I remember the
ndiswrappers needed for some of the drivers were
such an issue for so many back then. But by then, I
was committed to the open source mind set if there
was any feasible way to continue forward using it.
Today we have been without a Windows computer
anywhere for several years, but for several more we
have one dual booter somewhere – mainly for the
kids – as they would have issues with some school
work otherwise. CLARIFICATION: "We have been
without a Windows computer anywhere now for
several years..." is true on hardware only. I have a
Window OS on VM for use as needed, since VM
became an option, and there is a Win7 VM on my
PCLinuxOS desktop currently.

What specific equipment do you currently use
with PCLinuxOS?
My desktop is a Dell inspiron I got for some work I
did for an apartment complex network about two
years ago. It had Win 8.1 on it. Although it wasn't
brand new, it had only been run a short time and its
2TB HDD completely failed. It had never been
mirrored, so it was out an OS. I took it as part of the
payment for setting up their small office network in
Athens, Alabama that consisted of three terminals
(Two Windows and one Mac) and getting a few
shared resources up and available and helping their
office manager get their VPN working that links them
to their office in Atlanta. It has a quad core i5 Intel
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3GHz processor 8 GB RAM and a 1 TB HDD. My
main laptop is a HP dv6. iI has a dual core AMD
PhenomII 2.6GHz CPU 8Gb RAM and a
dangerously full 500 Gb HDD. Both are running
PCLinuxOS Full Monty. All other machines here are
running something else. Donna's laptop has UbuntuGnome 16 LTS, and my old ancient Lenovo T60 is
currently running Linux Pearl. It is the machine I do
new distros on and take any calculated risk on.

What would you like to see happen within
PCLinuxOS that would make it a better place.
What are your feelings?
Hmmm. That is almost a tough one. The reason
being is I personally have yet to see another
community as avid and as active as this one is. Just
look at the activity on the forums. That is amazing,
especially to be as small as the PCLinuxOS
community is when compared to some of the bigger
communities. I think we are great. I realize why we
are though, and I want to say I truly appreciate the
dedication I see reflected in the twitter of Texstar, or
with Meemaw or Paul Arnote and you David, with all
of you guy's dedication to PCLinuxOS or to its
magazine. We have a wonderful community of
testers that do a great job. And we have a very
responsive forum, replying to problems that anyone
might be experiencing with a much more
personalized attention than I have seen elsewhere.
That it makes us a better group here at PCLinuxOS
than it ever could be for the bigger guys. About the
only thing I think would help more than we currently
see, is some in depth tutorials for the absolute Linux
newbie, catered to take them first few miles, not only
into Linux but into PCLinuxOS. It would hit all the
most important stuff first, like burning an ISO, then
using that disc to install Full Monty, then how to
properly get that new OS updated using the
Synaptic update software (despite what we have
already on that subject, I still struggled with that as I
made the move to PCLinuxOS for far longer than I
feel confident in saying here). Maybe to properly set
up the drake connect firewall, or to setup a VPN,
maybe showing how is the best way to recover from
a frozen, locked up computer. I envision a desktop
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recorded YouTube style approach, but I have
personally seen well enough written tutorials for
other things in other distros that were written blog
style that were wonderful too. I wager I would find
value in some of those tutorials, and I don't consider
myself a novice to Linux, but I am sure not a power
user either.
I love this OS. I finally have found the one I will call
home. It is amazing, I am still discovering NEW (to
me) things about it to this day, things that impress
me. I love this community around this OS. When a
distro has all that going for it I think it is hard not to
be the best. The tutorials might make others realize
it too (even if they are the freshest minds to Linux) I
would like to see PCLinuxOS stay healthy, but I
wouldn't give up how being a smaller community
brings out the best in its membership.
PCLinuxOS Family Member Spotlight is an exclusive,
monthly column by YouCanToo, featuring PCLinuxOS
forum member. This column will allow "the rest of us" to
get to know our forum family members better, and will
give those featured an opportunity to share their
PCLinuxOS story with the rest of the world.
If you would like to be featured in PCLinuxOS Family
Member Spotlight, please send a private message to
youcantoo, parnote or Meemaw in the PCLinuxOS forum
expressing your interest.
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Predictions For PCLinuxOS Computing In 2018
by phorneker
This past year has been a year of progress for the
PCLinuxOS distribution, that was until the last three
months. Fortunately, the ransomware (such as
WannaCry) and other malware that spread
throughout the Internet did not directly affect
PCLinuxOS itself.
WannaCry (which has been traced back to North
Korean hackers), however, did affect Wine. The
good news here is that unlike Windows, users of
Wine could open a separate terminal and kill the
process controlling Wine, and then remove the
.wine directory to eradicate the malware.
With other malware running on Wine, the worst that
could happen is to trash the Wine installation, which
could be easily fixed by removing the .wine directory
and then reinstalling Wine from the repository.
What could not be fixed in PCLinuxOS is the data
breach experienced by Equifax, which turned out to
be more than just a simple human error. This breach
affected more than half of the US population (about
148 million), and could have been easily
prevented as early as December 2016, when the
vulnerability was first discovered. To make matters
worse, the software used to implement the Equifax
website and credit databases had numerous
security problems, because the server was running
an outdated version of Apache, which did not
contain the security patch that was supposed to
have been applied before the breach happened
back in May. That patch was available in March, and
the breach had not been discovered until July.
We cannot overemphasize the importance of
keeping your PCLinuxOS installation up to date, and
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this is an extreme example of why software should
be kept up to date, and what could happen if you do
not do so.
And as if that were not enough, thanks to the FCC
chairman and his ties to his former employer,
Verizon, net neutrality rules have been repealed .
What was Net Neutrality? Think of Net Neutrality as
the Civil Rights movement for Internet access
devices, that all data services, devices and
computing platforms should be treated with the
same respect. Under Net Neutrality, a PCLinuxOS
device could access the same services as a
smartphone, such as the latest Samsung Galaxy,
without any difference in speed or quality of the
connection.
This past year finally got PCLinuxOS an upgrade to
the latest GNU Compiler Collection and the
Standard C Libraries (the glib series of packages).
This was a jump in version from the version 4.9
series to the version 7.2 series, which was a badly
needed and very welcome change. This change was
needed to run the latest kernel (as of this writing
version 4.14.7).

That was 2017.

So what is to come for 2018?
With Net Neutrality off the table, it is now possible
that simply updating PCLinuxOS could bring on new
challenges.
This depends on how you connect to the Internet,
and in some cases, what Internet Service Provider
you are using.
Currently, Public Wi-Fi spots accept connections
from any device (as Net Neutrality rules prohibited
device discrimination). It is possible for a public WiFi spot to be configured to accept connections only
from smartphones and tablets, but not laptops
(unless you pay the right fee for such a connection,
or are in a place where most patrons bring in a
laptop such as a public library).
Cellular providers such as Verizon, AT&T, T Mobile
and TracFone (includes StraightTalk, Total Wireless
and Net10 brands) provide Mobile Broadband
service utilizing 4G LTE wireless routers and
smartphones.
Theoretically, you can use a smartphone as a 4G
modem (with a specialized application that shares
the 4G connection between your smartphone and
your PCLinuxOS machine).
The upside of this is that you can either prepay or be
billed for Internet service depending on what service
plan you signed up for. For 2018, this could prove to
also be a downside, depending on what service plan
you signed up for.
The reason this is a concern is that simply updating
PCLinuxOS could prove to be costly, if you are on
the wrong Internet service plan. (The initial update
after installation takes approximately one hour on a
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DSL connection.) Hence, you would want to get as
much data as possible for your monthly usage. This
is where the unlimited plans, especially from a
traditional Internet service provider, or one from
T-Mobile (and subsidiary MetroPCS) that has
truly unlimited data, are especially useful.
T-Mobile has always been a proponent of Net
Neutrality, hence the plans provided by T-Mobile and
MetroPCS are especially useful for PCLinuxOS.
As for malware and ransomware, we have been very
lucky, and as long as Linux itself does not get too
popular of a platform for consumer use, we should
expect to be relatively safe.

But, this does not mean we should let down our
guard when it comes to security and safety
threats. The next iteration of malware and
ransomware is expected to affect non-computer
devices, and could cripple the Internet itself if we
are not careful.
By non-computer devices, I mean smart televisions,
wireless printers, firmware controlling the information
system in automobiles and trucks, smart
refrigerators, and overhead paging systems in
certain facilities such as schools, hospitals, airports
and retail.
As for daily usage of PCLinuxOS on the Internet,
there is some good news. What constitutes an
Internet access device is no longer limited to a
computer, a tablet or a smartphone.
Devices such as Amazon’s Alexa (which powers the
Dish Network service as well as the newest
Kenmore refrigerators) and Echo, Google Home,
and similar devices mean that access from a Linux
machine should no longer be the issue it was just a
few years ago. (What do you think powers these
personal digital assistants? Linux, of course.)
As for Linux software…
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AppImage allows Linux applications and their
dependencies to be packaged inside a ISO9660based file format (not unlike a CD/DVD image).
For 2018, I do not see too much development for
PCLinuxOS here outside of AppImage, and even
then there is not too much software that has been
packaged as AppImage files. There is FlatPak and
Docker available, but these technologies depend on
the (infamous) systemd daemon. (This will never be
available for PCLinuxOS, and there is no reason
why it should be available to begin with.)

As for tech companies…
Google has been eyeing Chicago for its new
headquarters. Google already has an office inside
Merchandise Mart. Amazon wants to do the same
thing. Amazon has an office near Munster, Indiana
and a fulfillment center in Kenosha, Wisconsin. The
City of Gary, Indiana presented its case for Amazon
to move there (to Gary) rather than Chicago.
I do not know if this will happen. But there has been
some success for Gary as Canadian National
Railways made Kirk Yard (the ex-EJ&E facility next
to US Steel Gary Works) its primary Chicago area
rail terminal. (It is cheaper to fuel locomotives in
Indiana than it is to fuel locomotives in Illinois.) So
anything could happen.
Whatever happens over the next year, do not expect
too many changes to the way we use PCLinuxOS.
What will change, however, is the way we use the
Internet.

Users Don't
Text
Phone
Web Surf
Facebook
Tweet
Instagram
Video
Take Pictures
Email
Chat
While Driving.
Put Down Your
Phone & Arrive Alive.
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Tip Top Tips: Customizing Firefox 57
Editor’s Note: Tip Top Tips is a semi-monthly column in The PCLinuxOS Magazine.
Periodically, we will feature – and possibly even expand upon – one tip from the
PCLinuxOS forum. The magazine will not accept independent tip submissions specifically
intended for inclusion in the Tip Top Tips column. Rather, if you have a tip, share it in the
PCLinuxOS forum’s “Tips & Tricks” section. Your tip just may be selected for publication
in The PCLinuxOS Magazine.

This time, we feature seven tips from two different PCLinuxOS users: Ramchu
and Powhyfo. Because there are seven tips, but all dealing with the same topic
matter (customizing Firefox 57), the link to the forum tip for each will be kept with
each tip shown below, to make it easier for you to read each forum thread in its
entirety.
Even though some of the tips shown below defy any logical reason for why you
might want to even perform these tasks (like removing the hamburger menu or
removing the tab bar), they are shown because they show the relatively simple
process for customizing Firefox 57. Similarly, some of these tips may not “be for
you,” but there is a lot to learn about the process involved.
We’ll follow up by pointing you to some “other” resources for customizing Firefox
57. Despite how short of a time Firefox 57 has been out (it was released on
November 14, 2017), the tinkerers and hackers have been working overtime on
figuring out where their boundaries are with Firefox 57. There is no doubt that the
number of these “other” resources will grow considerably in the quite near future.
These “other” resources, along with the examples below, should get you a good
start on understanding and learning how to customize Firefox 57, if you are
interested in that sort of thing.
Finally, if you’re worried about messing up your Firefox settings, you have a
couple of choices. First, you can set up a “test” user on your system, and test
your Firefox 57 customizations there before altering Firefox 57 on your main user
account. Second, you can just delete the offending portions of the
userChrome.css file – or the entire file, for that matter – and start over. The
settings are kept on a user-by-user basis, in the hidden
.mozilla/firefox/default/chrome folder, in each user’s /home directory.

Tabs on Bottom in FireFox 57 (Below Navigation Bar) by Ramchu
This will put your Tabs below the Navigation bar; NOT at the bottom of the
screen.
Open your file manager (in my case its Dolphin).
Show hidden files (Dolphin>control>Hidden Files).

Open the .mozilla folder.
Then open the firefox folder.
Next open the default folder (mine is named something like this:
gdrj46iv.default).
Now Right click and create a New Folder named chrome.
Open the newly created chrome folder.
Now open your favorite text editor and create a new text file and copy and paste
the below code:
/* Tab bar below Navigation & Bookmarks Toolbars
For best results, show Title Bar or Menu Bar */
#nav- bar { /* main toolbar */
- moz- box- ordinal- group: 1 ! important;
border- top- width: 0 ! important;
}
#PersonalToolbar { /* bookmarks toolbar */
- moz- box- ordinal- group: 2 ! important;
}
#TabsToolbar { /* tab bar */
- moz- box- ordinal- group: 3 ! important;
}

Now save the file as: userChrome.css and put it in the newly created chrome
folder.
The next time you open Firefox 57, the tabs bar will be at the bottom.
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BEFORE

AFTER

/* Multi- Row Bookmarks Toolbar */
#PersonalToolbar {
/* Provide room for up to 4 rows at 26px */
max- height: 104px ! important;
}
#PlacesToolbarItems > box {
display: inline- block ! important;
}
#PersonalToolbar #PlacesToolbarItems {
/* Override hiding */
overflow- x: visible ! important;
overflow- y: visible ! important;
/* Add a little cushion */
padding- bottom: 1px;
}
#PersonalToolbar #PlacesToolbarItems . bookmark- item {
/* Reduce padding on individual bookmarks to fit rows closer
together */
padding- top: 1px ! important;
padding- bottom: 1px ! important;
}

Before:

Multi Row Bookmarks Toolbar in Firefox 57 by Ramchu
Open your file manager and show hidden files.

After:

Open the .mozilla folder.
Open the firefox folder.
Open the default folder.
Open the chrome folder (if the chrome folder does not exist- Right click and
create new).

Multiple row tabs in Firefox 57 by Ramchu

Open the userChrome.css file. (If you don't have one - Open your favorite editor
and create a new file and name it userChrome.css. Save it into the chrome
folder.)

Show hidden files.

Copy and paste the code into the userChrome.css file and click save.
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Open your file browser.
Open the .mozilla folder.
Open the firefox folder.
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Open the default folder.
Open the chrome folder. (If it doesn't exist right click, create new folder and name
it chrome).
Open the userChrome.css file. (If there isn’t a userChrome.css file, open your
favorite text editor, and create a new file).
Copy and paste the code below into the userChrome.css file and save it.
Close and Reopen FireFox. You should now have the multiple tab row option.
/*
The class . tabbrowser- tabs has been replaced with id #tabbrowsertabs
changed selectors accordingly
*/
. tabbrowser- tab: not( [ pinned] ) {
flex- grow: 1;
min- width: 94px ! important; /* Needed important tag, width can
be whatever you like */
max- width: 94px ! important; /* none - Makes the tabs always
fill the toolbar width */
}
. tabbrowser- tab, . tab- background {
height: var( - - tab- min- height) ;
}
. tab- stack {
width: 100%;
}
#tabbrowser- tabs . scrollbox- innerbox {
display: flex;
flex- wrap: wrap;
overflow- y: auto ! important;
min- height: var( - - tab- min- height) ;
max- height: calc( 3*var( - - tab- min- height) ) ! important; /* 3
rows */
}
#tabbrowser- tabs . arrowscrollbox- scrollbox {
overflow: visible;
display: block;
}

#main- window[ sizemode=" maximized" ] #titlebar{
margin- bottom: calc( 6px + var( - - tab- min- height) *- 1) ! important;
}
#main- window[ sizemode=" maximized" ] #TabsToolbar{
margin- left: var( - - tab- min- height) ;
}
#titlebar: active{
margin- bottom: 0 ! important;
}
#titlebar: active #titlebar- content{
margin- bottom: var( - - tab- min- height) ! important;
}
#tabbrowser- tabs . scrollbutton- up, #tabbrowser- tabs . scrollbuttondown, #alltabs- button, . tabbrowser- tab: not( [ fadein] ) {
display: none;
}
/* This enables maximum width before scrollbar is shown */
#main- window[ tabsintitlebar] #tabbrowser- tabs {
- moz- window- dragging: no- drag;
}
/* Show close button on hover */
. tab- close- button{ display: none }
. tabbrowser- tab: not( [ pinned] ) : hover . tab- close- button{
display: - moz- box ! important
}

Before

After

#titlebar, #titlebar- buttonbox{
height: var( - - tab- min- height) ! important;
}
#titlebar{
margin- bottom: calc( var( - - tab- min- height) *- 1) ! important;
}
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Hide the Tabs bar in Firefox 57 by Powhyfo

Prevent Firefox 57 closing with last tab by Powhyfo

Edit the /home/~user/.mozilla/firefox/***.default/chrome/userChrome.css file to
add these lines:

I am terrible about closing the last tab without thinking and sure enough, Firefox
closes when I do it.

/* Hide the tab bar */
#tabbrowser- tabs { visibility: collapse ! important; }

To stop Firefox from closing go to about:config and change the value of

This is useful if you are using the vertical tabs add-on and want to hide Firefox's
tab bar.

browser.tabs.closeWindowWithLastTab from true to false.
Now when you close the last tab Firefox will open a new tab and remain open.

Hide 'Hamburger' button in Firefox 57 by Powhyfo

“Other” Resources

Edit the /home/~user/.mozilla/firefox/***.default/chrome/userChrome.css file to
add these lines:

First, if you search for “firefox 57 css,” you’re going to receive a LOT of results.
The previous link points to the “Let Me Google That For You” site, so if you’re
anti-Google, you might not want to click on it. The results will only grow over time
as more and more users learn the ins-and-outs of customizing the
userChrome.css file that controls the user interface in Firefox 57 and beyond.

/* Remove the Hamburger Button */
#PanelUI- menu- button {display: none; }

This will remove three horizontal line 'options' button from the far right side of the
toolbar.

Tabs on Bottom of screen in FireFox 57 by Powhyfo
After doing the move tabs to bottom of navigation bar (not screen) found here:
https://www.pclinuxos.com/forum/index.php/topic,144329.0/topicseen.html
Add these lines underneath:
/* Tabs on bottom of screen */
#TabsToolbar {
position: fixed;
bottom: - 0. 0em;
width: 100%;
}
#tabbrowser- tabs { width: 96%; }
#content- deck { margin- bottom: 2. 5em; }

...and viola! Tabs are down where they belong.
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Reddit has a whole thread of tweaks, tinkerings and hacks dedicated to Firefox
57. Ramchu did mention in one of his threads that some of his “tips” came from
there. This is also an ever-growing collection of Firefox 57 customization tips.
Aris-t2 has a GitHub page where he discusses customizing Firefox 57, and even
has working, full-blown examples of userChrome.css files that you can try out on
your computer. One thing that Aris-t2 has done is recreate the old Firefox add-on
“Classic Theme Restorer” by editing the userChrome.css file. While not as robust
and functional as the old “Classic Theme Restorer,” he has captured the look and
feel of it pretty accurately. His iteration of it is available for download from his
GitHub page. Even better, he has listed many about:config customizations, as
well. While userChrome.css addresses the GUI for Firefox 57, it can’t really touch
the inner workings of Firefox 57. For that, you need to go into about:config and
turn things on and off.

Summary
Personally, I wish I had the time to dig into this a bit further. But, with being Mr.
Mom three days a week, working a fulltime job at the hospital, doing magazine
work, keeping up with what’s going on in the forum, keeping my computers
updated, keeping up with tasks around home (repairs, lawn work, etc.), and trying
to include some “fun” things to do in there – and keep it all balanced – there just
isn’t any additional time. So I will have to leave the discoveries of all the really
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Tip Top Tips: Customizing Firefox 57
cool things that can be done with userChrome.css in
Firefox 57 to those who have more available time to
dig into its ins and outs.
Still, the new Firefox 57 interface seems very
malleable and rather easy to customize. Admittedly, I
was apprehensive about Firefox 57 and its new
direction. But after having used it, I’m very excited
about Firefox’s future. The new found speed, the
slimming down of its code base, and its relative ease
of customization have left me awestruck and eagerly
anticipating its future.

Screenshot Showcase

DOWNLOAD

Mate Desktop
Does your computer run slow?
Are you tired of all the "Blue Screens
of Death" computer crashes?
Are viruses,
adware, malware &
spyware slowing
you down?
Get your PC back
to good health
TODAY!
Get
Posted by OnlyHuman on December 11, 2017, running e22.

Download your copy today! FREE!
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ms_meme's Nook: Boot It!
I told that Windows
Don't you come around here
Don't wanna see your desktop
So just disappear
Take my advice
My words are very clear

Don't get a virus
Leave Windows while you can
Don't be a Gate's boy
Be a Linux man
Use PCLinuxOS
It has a good plan

DON'T BOOT IT
DON'T BOOT IT

SO BOOT IT
JUST BOOT IT

Of PCLinuxOS
I'm a big fan
Made by Texstar
He is a macho man
It does everything
That Windows can

Using that Windows
Will give you a scare
Something goes wrong
Nobody will care
Download PCLinuxOS
Be treated fair

SO BOOT IT
JUST BOOT IT

SO BOOT IT
JUST BOOT IT
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PCLinuxOS Bonus Recipe Corner
Tips:
How hot is Tennessee hot? It's up to you. We
suggest a range of cayenne pepper from 1/2 to 1
teaspoon. At the lower end of the range, you will feel
it, but it won't be overwhelming. At the upper end of
the range, you will definitely get a more intense heat.

Tennessee Hot Chicken Tenders
Ingredients
1 package (14 oz) uncooked chicken tenders
1 teaspoon salt
1/2 teaspoon freshly ground black pepper
1 cup all-purpose flour
1/2 cup buttermilk
1 teaspoon cayenne pepper sauce
2 cups vegetable oil
3 tablespoons butter
1 teaspoon paprika
1/2 to 1 teaspoon ground red pepper (cayenne)
1/4 teaspoon garlic powder

To cool the heat a bit, you could serve your favorite
ranch dressing alongside these tenders as a dipping
sauce.

about 5 minutes, turning once, until deep golden
brown and no longer pink in center (at least 165F).
Place on rack lined with paper towels to drain, with
paper towels underneath rack.

DOWNLOAD

4. In 1-quart saucepan, melt butter over mediumlow heat. Beat in paprika, red pepper and garlic
powder with whisk. Brush fried chicken tenders with
spicy butter. Serve with slices of white bread and
sweet pickles, if desired.

Mate Desktop

Directions
1. Season chicken tenders with 1/2 teaspoon of the
salt and 1/4 teaspoon of the pepper.
2. In shallow bowl, mix flour, remaining 1/2
teaspoon salt and remaining 1/4 teaspoon pepper
with whisk. In another shallow bowl, beat buttermilk
and hot sauce together with whisk. Dredge chicken
tenders in seasoned flour, then in buttermilk mixture,
and back in flour.
3. In 12-inch skillet, heat oil over medium-high heat
until hot (350F). Fry tenders in hot oil, all at once,
PCLinuxOS Magazine
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PCLinuxOS Puzzled Partitions

When you start a game of Sudoku, some blocks will be prefilled
for you. You cannot change these numbers in the course of the
game.
Each column must contain all of the numbers 1 through 9 and
no two numbers in the same column of a Sudoku puzzle can
be the same. Each row must contain all of the numbers 1
through 9 and no two numbers in the same row of a Sudoku
puzzle can be the same.
Each block must contain all of the numbers 1 through 9 and no
two numbers in the same block of a Sudoku puzzle can be the
same.
PCLinuxOS Magazine

Download Puzzle Solutions Here

SUDOKU RULES: There is only one valid solution to each
Sudoku puzzle. The only way the puzzle can be considered
solved correctly is when all 81 boxes contain numbers and the
other Sudoku rules have been followed.

SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the English language. Non-English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You will not necessarily
be able to use all seven (7) of the letters in
your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is a
list of how they are scored:
0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z
6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to 12
minutes per letter tile set.
7. Have fun! It's only a game!

Possible score 263, average score 184.
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PCLinuxOS Word Find: January 2018
Winter Weather
Accumulation
Arctic
Avalanche
Barometer
Blizzard
Blustery
Chilblains
Crystals
Dew point
Exposure
Flurries
Frigid
Frostbite
Heat
Hibernate
Holidays
Ice skating
Icicle
Igloo
Winter
Insulation
Long johns
Medication
Meteorologist
Moisture
Influenza
North wind
Overcast
Polar
Quake
Quantity
Refrigeration
Resistance
Skiing
Sleet
Snowball
Snowmobile
Subzero
Temperatures
Tundra
Umbrella
Visibility
Weather
Wind
National Weather Service

Download Puzzle Solutions Here
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Winter Weather Crossword
1. the state of the atmosphere at a place and time as
regards heat, dryness, sunshine, wind, rain
2. characterized by strong winds
3. the sky marked by a covering of gray clouds
4. highly contagious viral infection of the respiratory
passages causing fever & severe aching
5. the coldest season of the year
6. a vast, flat, treeless Arctic region in which the
subsoil is permanently frozen
7. an inflammation of the hands and feet caused by
exposure to cold and moisture
8. a mass of snow, ice, and rocks falling rapidly down
a mountainside.
9. the refusal to accept or comply with something
10. a dome-shaped Eskimo house, typically built from
blocks of solid snow
11. material used to insulate something against the
cold
12. injury to body tissues caused by exposure to
extreme cold
13. underwear with closely fitted legs that extend to
the wearers ankles, often with a long-sleeved top
14. an instrument measuring atmospheric pressure
15. the atmospheric temperature below which water
droplets begin to condense and dew can form
16. the degree or intensity of heat present in a
substance or object
17. spend the winter in a dormant state or indoors
18. a weather forecaster
19. a protecting force or influence
20. the distance one can see as determined by
weather conditions

Download Puzzle Solutions Here
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Cryptograms

PCLinuxOS Puzzled Partitions

From the computer of ms_meme:

Everyday I work the daily crosswords and cryptograms in the paper. I like the cryptograms as they are wise/silly sayings of famous
people. The magazine article about secure passwords made me think of the cryptograms. We have people in the forum who are
always posting famous/wise/silly sayings. I have made a few into cryptograms, and hope our readers will enjoy them.

Download Puzzle Solutions Here
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More Screenshot Showcase
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Posted by mutse, on December 25, 2017, running KDE.

Posted by Meemaw, on December 2, 2017, running Xfce.

Posted by jogurtmen, on December 6, 2017, running Mate.

Posted by `ĦξŘŤζ_, on December 3, 2017, running Mate.
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